Announcement about the Open Source Software
The information about licenses of each OSS used in the camera is saved in the camera internal memory as a text file. Connect the camera to a computer after setting [USB Connection] to [CD-ROM] in the menu of the camera, and then open the text file in the “oss_license_sw” folder to read the license terms.

- To ensure safe use, be sure read “Safety Precautions” in the Operating Manual of the camera before using the software.
- The provided software is compatible with Windows only. Refer to the Operating Manual of the camera for the detailed operating environment.
Contents

Installing the Software ..................................... 3
Provided Software .................................................. 3
Operating Environment .......................................... 3
Installing the Software .......................................... 3

Importing Images ............................................. 4
How to Import Images ........................................... 4
Setting up DL-20 Operation ..................................... 5
Using DL-20 ......................................................... 5

Creating Camera Memos .................................... 7
What Is a Camera Memo? ........................................ 7
Example of the Camera Memo ............................... 7
Creating a Camera Memo List ................................ 7
Setting an Image in the Camera Memo List ............ 9
Transferring a Camera Memo List to the Camera ...... 9

Browsing Images ............................................. 10
Checking Images .................................................. 10
Printing Images ................................................... 11

Managing Images ............................................. 12
Setting the Image Management Method ............... 12
Output File Information ........................................ 13

Making Network Settings (G900SE Only) .......... 15
Creating a Communication List .......................... 15
Transferring the Communication List to the Camera ......................................................... 18

Transferring Employee Information Files
(G900SE Only) ..................................................... 19

Setting Up the Camera Dedicated Server
(G900SE Only) .................................................... 20
Installing the Software

Provided Software

The following software is provided with the camera.

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DL-20</td>
<td>Used to import images from the camera to a computer. (p.5)</td>
</tr>
<tr>
<td>LE2</td>
<td>Used to create a camera memo list (.mta). (p.7)</td>
</tr>
<tr>
<td>ME2</td>
<td>Used to view images. You can edit the camera memo and print the image and camera memo together on a sheet. (p.10)</td>
</tr>
<tr>
<td>EX2</td>
<td>Used to rename image files according to the options set in the camera memo. (p.12)</td>
</tr>
<tr>
<td>ST-20</td>
<td>Used to make the detailed wireless LAN settings and create a communication list (.PRM). (p.15) (G900SE only)</td>
</tr>
<tr>
<td>SR-20</td>
<td>Used to set up a computer as a server dedicated to the camera. (p.20) (G900SE only)</td>
</tr>
</tbody>
</table>

Installing the Software

   Refer to the Operating Manual of the camera.
2. Turn the camera off.
3. Connect the camera to the computer with the USB cable.
4. Turn the camera on.
   The installer starts up.
5. Click [Installing DC Software II].
   The installer starts up.
   Follow the instructions on the screen.

Memo

- The DL-20, SR-20, and EX2 software are always resident in the system tray. Double-click the icon in the system tray at the right end of the taskbar to launch the software.

Operating Environment

The provided software is compatible with Windows only. The operating environment of the software is as shown below.
- Windows® 10 (32-bit, 64-bit)
- Windows® 8.1 (32-bit, 64-bit)
- Windows® 7 (32-bit, 64-bit)
- Windows Server® 2019 (64-bit)
- Windows Server® 2016 (64-bit)
- Windows Server® 2012 R2 (64-bit)
- Windows Server® 2008 R2 (64-bit)
Importing Images

How to Import Images

The following methods are available to import images to a computer.

Importing images with File Explorer
Get your computer to recognize the camera as a device, and select and copy images. Refer to the Operating Manual of the camera for details.

Importing images with DL-20
If DL-20 is installed, DL-20 is automatically launched when the camera is connected. This manual describes the method to import images using DL-20.

Memo
• When importing images from the camera, insert a battery with enough capacity remaining to the camera. The use of an AC adapter (optional) is recommended.
• If a memory card is inserted, files are imported from the memory card. If no memory card is inserted, files are imported from the internal memory.

Caution
• Do not disconnect the USB cable while images are being imported.
• Do not format the memory card or internal memory from the computer. Perform formatting using the camera only.
• Always eject the USB cable in the computer before disconnecting it.
• If images were imported to the computer using image management software, etc., they cannot be displayed on the camera even if they are copied to a memory card.
• Only one RICOH camera can be connected to a computer. Do not try to connect more than one RICOH camera to the computer.

• When importing images from the camera, insert a battery with enough capacity remaining to the camera. The use of an AC adapter (optional) is recommended.
• If a memory card is inserted, files are imported from the memory card. If no memory card is inserted, files are imported from the internal memory.

Memo
• When importing images from the camera, insert a battery with enough capacity remaining to the camera. The use of an AC adapter (optional) is recommended.
• If a memory card is inserted, files are imported from the memory card. If no memory card is inserted, files are imported from the internal memory.

Caution
• Do not disconnect the USB cable while images are being imported.
• Do not format the memory card or internal memory from the computer. Perform formatting using the camera only.
• Always eject the USB cable in the computer before disconnecting it.
• If images were imported to the computer using image management software, etc., they cannot be displayed on the camera even if they are copied to a memory card.
• Only one RICOH camera can be connected to a computer. Do not try to connect more than one RICOH camera to the computer.
Setting up DL-20 Operation

1. Double-click the DL-20 icon in the system tray at the right end of the computer taskbar.
   The DL-20 screen appears.

2. Click [ ].

3. Set up the import operation.

   - Place a check mark to automatically import the images when the camera is connected.
   - When DL-20 is installed, the [Digital Camera] folder is automatically created in the [Documents] folder. Click [Browse] to change the import destination.
   - Select whether to create sub-folders when importing images.
   - If previously imported images exist in the camera, select whether to import them again.
   - Software can be registered. You can launch the registered software by clicking [Launch User Application] on the screen in Step 2.
   - Place a check mark to launch the registered software after importing the images.

4. Click [OK].
   The screen in Step 2 reappears.

5. Click [×].

Caution

- Set the date and time correctly in the camera. If the date and time are not set correctly, a folder is not created with the correct date and time when [For each date photographed] is selected for [Create folder] in Step 3. Also, duplicate images may be saved if a check mark is placed in [Exclude images that have been imported even once].

Using DL-20

   Refer to the Operating Manual of the camera for details.

2. Turn the camera off.

3. Connect the camera to the computer with the USB cable.

4. Turn the camera on.
   If a check mark is placed in [Saves automatically when connected to USB], proceed to Step 6.

5. Click [Import Images].
   The images are imported to the set folder.
6 Click [OK].

![Image of DL-20 transfer completion]

**Caution**

- The images captured while [New Folder Options] is set to [Date] or [Custom] in the menu of the camera cannot be imported with DL-20. When the images cannot be imported, copy them with File Explorer or other software.
- For the images captured while [File name] is set to [Custom] in the menu of the camera, the file name is changed to “RIMG＊＊＊.JPG” when they are imported to a computer with DL-20.
Creating Camera Memos

What Is a Camera Memo?

If you register information such as shooting location and work situation in advance, you can add the work site information to captured images simply by selecting it during shooting. This information is called the “camera memo”.

Example of the Camera Memo

<table>
<thead>
<tr>
<th>Item Name (Memo Item)</th>
<th>Description (Options)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Company A, Company B, Company C</td>
</tr>
<tr>
<td>Construction name</td>
<td>Foundation work, Piping work, Interior finish work</td>
</tr>
<tr>
<td>Shooting location</td>
<td>Outdoors, Entrance, Kitchen, Living room</td>
</tr>
<tr>
<td>Photographer</td>
<td>(Reading barcode, employee ID card, etc.)</td>
</tr>
</tbody>
</table>

For images with a camera memo added, you can print them together with registered information and change the file names to the options set in the camera memo in a batch. This manual explains how to create the camera memo information (camera memo list) to be added to images using the provided software LE2.

Memo

- For how to add camera memos during shooting, refer to the Operating Manual of the camera.

Creating a Camera Memo List

1. Launch LE2 on the computer.

   The LE2 screen appears.

2. Click [Add] for [Item name].

3. Enter the memo item.

   You can enter up to 20 characters for [Item name].

4. Click [Add] for [Description].

5. Enter the option.

   You can enter up to 128 characters for [Description].
6 Repeat Steps 4 and 5 to enter the options for the memo item.

- Click [Up] and [Down] to change the display order of the options.
- Click [Edit] to change the options.
- You can register up to 999 options for [Description].

7 Repeat Steps 2 to 6 to enter all the required memo items and options.

- You can register up to 100 memo items for [Item name].

8 When everything has been entered, select [Save As] in the [File] menu.

9 Enter the file name in [File Name], specify the save destination, and click [Save].

The camera memo list is saved with the extension “.mta”.

---

**Memo**

- You can also use LE2 to import a CSV-format file created using other software as the camera memo list. Similarly, the camera memo list created using LE2 can be saved in the CSV format.

- When [Camera Memo Mode] is set to [Mode3] in the **M** menu of the camera, the [Description] options for a memo item vary depending on the option selected for the previous memo item.

<table>
<thead>
<tr>
<th>Options for Memo Item 1</th>
<th>Options for Memo Item 2</th>
<th>Options for Memo Item 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A1</td>
<td>A1a</td>
</tr>
<tr>
<td></td>
<td>A1b</td>
<td>A1c</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>A2a</td>
</tr>
<tr>
<td></td>
<td>A2b</td>
<td>A2c</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>A3a</td>
</tr>
<tr>
<td></td>
<td>A3b</td>
<td>A3c</td>
</tr>
<tr>
<td>B</td>
<td>B1</td>
<td>B1a</td>
</tr>
<tr>
<td></td>
<td>B1b</td>
<td>B1c</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>B2a</td>
</tr>
<tr>
<td></td>
<td>B2b</td>
<td>B2c</td>
</tr>
<tr>
<td></td>
<td>B3</td>
<td>B3a</td>
</tr>
<tr>
<td></td>
<td>B3b</td>
<td>B3c</td>
</tr>
</tbody>
</table>

**Caution**

- The following characters cannot be used in the [Item name] or [Description]: 
  
  `/ : ? * " < > |`
**Setting an Image in the Camera Memo List**

By registering an image file in [Description] for the camera memo, the image can be used as the camera memo information. A JPEG image (.jpg) that meets the following conditions can be registered.

<table>
<thead>
<tr>
<th>Number of pixels</th>
<th>Width: 32 to 4608; Height: 32 to 3456</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color space</td>
<td>YCbCr 4:2:2 (width pixels a multiple of 16 and height pixels a multiple of 8) YCbCr 4:2:0 (width and height pixels a multiple of 16)</td>
</tr>
<tr>
<td>File size</td>
<td>12 MB or less</td>
</tr>
</tbody>
</table>

1. Copy the image to be registered in the camera memo to the “TEMPLATE” folder in the memory card or internal memory.

2. Launch LE2 and enter the image file name in [Description] for the last [File name].

   The image is not recognized if it is set for an intermediate [File name].

**Transferring a Camera Memo List to the Camera**

1. Check where the camera memo list is transferred.

   When transferring the list to a memory card, a memory card formatted with the camera must be inserted to the camera. If no memory card is inserted, the list is transferred to the internal memory.

2. While LE2 is running, connect the camera to the computer, and turn it on.

3. Select [Open] in the [File] menu to display the camera memo list to be transferred.


   The camera memo list is transferred to the camera.

**Caution**

- An image can only be selected as the camera memo option during shooting if [Camera Memo Mode] is set to [Mode2] in the menu of the camera.

- If the camera memo list is not transferred, check that [USB Connection] is set to [MSC] in the menu of the camera.

- The camera memo list is copied to the “TEMPLATE” folder in the memory card or internal memory. When copying the camera memo list using File Explorer or other software, copy it to the “TEMPLATE” folder.

- The camera memo list cannot be transferred if no “TEMPLATE” folder exists. The “TEMPLATE” folder is created when the memory card is formatted using the camera.

- The camera memo list transferred to the internal memory or memory card is not deleted even when the internal memory or memory card is formatted. Use File Explorer to delete the list.
Browsing Images

Checking Images

1. Launch ME2 on the computer.

The ME2 screen appears.

2. Select the folder where the images are stored in the folder tree.

The images are displayed.
When images are imported using DL-20, they are saved in the set folder. (p.5)

3. Check the images.

Three icons are displayed by the thumbnail to show detailed information about the image. Double-click an icon to show the details. If the icon is grayed out, no information is available.

<table>
<thead>
<tr>
<th>Icon 1</th>
<th>Icon 2</th>
<th>Icon 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the image clip if a clip image is added.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Displays the GPS information if GPS data is added.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Displays the camera memo information if a camera memo is added. The camera memo can be edited.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

RIMG0002.JPG
**Printing Images**


2. Set the print format, etc.
   - **[Options]**
     Select the number of images per page and the options to be printed.

   - **[Memo]**
     Set the print format for printing the camera memo information.

3. Select the images to be printed.
   Check the print preview.
5. Click [Close].
   Select the printer, etc., and print the images.
Managing Images

Setting the Image Management Method
You can set the classification method when importing images and the renaming rule for file names.

1. Right-click the EX2 icon in the system tray, and click [Transfer Settings].
   The [Transfer Settings] screen appears.

2. Click [Browse], and specify the folder where the images to be imported are stored.

3. Make settings for [Process].
   Place a check mark for the required processing items, and click [Detail].
   [Categorize folder]
   Set the naming rule for created folders.
   [Change file name]
   Set the naming rule for files when renaming them during import.

4. Specify the [Save To] folder.

5. Click [OK].

[Output camera memo information file]
Camera memo information can be output in the XML, CSV, or TXT file format. An XSLT stylesheet can be used.

[Launch application]
Register software to launch after the import is complete.
Memo

- Right-click the EX2 icon, and click [Property] to set the EX2 properties.

1 Starts monitoring the folder where the images to be imported are stored as soon as EX2 is launched.

2 Outputs the import results log. Specify the path and file name of the log file, maximum file size, and number of files in the history.

- Right-click the EX2 icon and place a check mark to [Enable a folder monitoring] to continuously monitor the folder where the images to be imported are stored and automatically import any images that are changed.
- Right-click the EX2 icon and place a check mark to [Enable auto launch] to launch EX2 automatically when the computer starts.

Output File Information

The following information is output when the [Export Format] settings are used.

<table>
<thead>
<tr>
<th>Information Item</th>
<th>Tag Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shooting date</td>
<td>DateTimeOriginal</td>
</tr>
<tr>
<td>Latitude (N/S)</td>
<td>GPSLatitudeRef</td>
</tr>
<tr>
<td>Latitude (numeric value)</td>
<td>GPSLatitude</td>
</tr>
<tr>
<td>Longitude (E/W)</td>
<td>GPSLongitudeRef</td>
</tr>
<tr>
<td>Longitude (numeric value)</td>
<td>GPSLongitude</td>
</tr>
<tr>
<td>Camera memo item and option</td>
<td>CameraMemo1</td>
</tr>
<tr>
<td>Memo item</td>
<td>MemoItem1</td>
</tr>
<tr>
<td>Memo option</td>
<td>MemoData1</td>
</tr>
</tbody>
</table>

Example: XML format

```xml
<?xml version="1.0" encoding="Shift_JIS"?>
<Exif>
  <APP1>
    <Exif_IFD>
      <DateTimeOriginal>2019:05:05 00:00:00</DateTimeOriginal>
    </Exif_IFD>
    <GPS_IFD>
      <GPSLatitudeRef>N</GPSLatitudeRef>
      <GPSLatitude>00:00:00</GPSLatitude>
      <GPSLongitudeRef>E</GPSLongitudeRef>
      <GPSLongitude>00:00:00</GPSLongitude>
    </GPS_IFD>
  </APP1>
  <APP5>
    <CameraMemo1>
      <MemoItem1>Memo item 1</MemoItem1>
      <MemoData1>Option A</MemoData1>
    </CameraMemo1>
    <CameraMemo2>
      <MemoItem2>Memo item 2</MemoItem2>
      <MemoData2>Option B</MemoData2>
    </CameraMemo2>
  </APP5>
</Exif>
```
Example: CSV format

<table>
<thead>
<tr>
<th>DateTimeOriginal,2019:05:05 00:00:00</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPSLatitudeRef,N</td>
</tr>
<tr>
<td>GPSLatitude,00:00:00</td>
</tr>
<tr>
<td>GPSLongitudeRef,E</td>
</tr>
<tr>
<td>GPSLongitude,00:00:00</td>
</tr>
<tr>
<td>Memo item 1, Option A</td>
</tr>
<tr>
<td>Memo item 2, Option B</td>
</tr>
<tr>
<td>Memo item 3, Option C</td>
</tr>
<tr>
<td>Memo item 4, Option D</td>
</tr>
<tr>
<td>Memo item 5, Option E</td>
</tr>
</tbody>
</table>

Example: TXT format

```
[DateTimeOriginal]
2019:05:05 00:00:00
[GPSLatitudeRef]
N
[GPSLatitude]
00:00:00
[GPSLongitudeRef]
E
[GPSLongitude]
00:00:00
[CameraMemo1]
Memo item 1
Option A
[CameraMemo2]
Memo item 2
Option B
[CameraMemo3]
Memo item 3
Option C
[CameraMemo4]
Memo item 4
Option D
[CameraMemo5]
Memo item 5
Option E
```
Making Network Settings (G900SE Only)

Creating a Communication List

You can create a list of file transmission destinations for connecting the camera via a wireless LAN and transmitting files as the “communication list”.

1 Launch ST-20 on the computer.

2 Click [Add], and enter a name for the settings.

Multiple file transmission destinations can be saved in a single file.

3 Make the settings on the [Network] tab.

Enter the camera IP address and DNS server (optional).

   1 Select [Automatically retrieves its IP address] to automatically obtain the camera IP address. To use a specific IP address enter it as follows: [IP address]: Fixed IP address of camera [Subnet Mask]: Usually set to “255.255.255.0”. [Gateway]: IP address of a computer connected to the Internet

2 Select [Automatically retrieves the address from the DNS server] to automatically obtain the DNS server address. To use a specific address, enter the [Primary DNS server] and [Secondary DNS server].

4 Make the settings on the [Wireless LAN Setting] tab.

Select the camera model and make the access point settings.

   1 [Infrastructure STA]: Communication is established in the station mode. [Infrastructure AP]: Communication is established in the access point mode.

   2 When [Config. Connexion] is set to [Infrastructure STA], enter the same ESS-ID as the access point.
   When [Config. Connexion] is set to [Infrastructure AP], enter any required ESS-ID.

   3 When [Config. Connexion] is set to [Infrastructure AP], select the channel for [Channel].

   4 When [WEP], [AES/TKIP], or [AES] is set, setting of [Network Key] is required.

   5 Enter the network key in [Text Mode] or [Hex] according to the [Encryption] setting.

   6 Select the authentication type.
Make the settings on the [FTP/FTPS Server Options] tab.

Set the server to transfer the images to.

1. Enter the IP address of the destination server.
2. Enter the user ID and password required for the server connection. The user ID and password are not required if your computer is set as the server.
3. Set the folder to transfer the images to.
4. Place a check mark to overwrite images with duplicate file names at the destination server. When the check mark is removed, images with an existing file name are not transferred. If a file name is duplicated when your computer is set as the SR-20 server, it is replaced with another file name and saved.
5. Place a check mark to connect the server in the passive mode.
6. Set the port number.
7. Select the encryption type. When [Explicit] or [Implicit] is selected, SSL/TLS encryption is used for communications.
8. Specify the path of the certificate file transferred to the camera. A certificate file in the PEM or DER format can be selected.

Make the settings on the [Web Server Setting] tab.

Make the settings when a web server is used. Refer to Steps 3 to 5 for details about these settings.

Make the settings on the [Auto Update Server Options] tab.

Make the settings to automatically transfer the camera firmware and camera memo list to the camera and to synchronize the date and time settings between the camera and the server. Refer to Step 5 for details about these settings. The setting for [Folder] is not necessary.
8 Make the settings on the [802.1x Authentication] tab.
Information from the existing user authentication system can be used to connect to the server.

1 Enter the name of the authentication server.
2 Select the authentication type.
3 Enter the user ID and password required to connect to the authentication server.
4 Enter the domain name to log in to the authentication server.
5 Specify the path and file name of [Root certificate], [Client certificate], and [Client key] transferred to the camera.
Certificate files in the PEM, DER, or PFX format can be selected. When a certificate file in the PFX format is selected, enter the password.

9 When the settings have been made, select [Save As] in the [File] menu.

10 Enter the file name in [File Name], specify the save destination, and click [Save].

11 Enter the password in [Password], and click [OK].
The communication list is saved with the extension “.PRM”.
The password is used when opening the files with ST-20.

Memo
• The screen state when ST-20 is launched can be set in [Start-up Settings] in the [File] menu.
Transferring the Communication List to the Camera

1. Check where the communication list is transferred.
   When transferring the list to a memory card, a memory card formatted with the camera must be inserted to the camera. If no memory card is inserted, the list is transferred to the internal memory.

   Refer to the Operating Manual of the camera for details.

3. Turn the camera off.

4. While ST-20 is running, connect the camera to the computer, and turn it on.

   The [Select Transfer Target] screen appears.

6. Select the name of the settings to transfer.

7. Click [Transfer].
   The communication list is sent to the camera.

---

**Caution**
- If the communication list cannot be transferred, check that [USB Connection] is set to [MSC] in the menu of the camera.
- The communication list is copied to the “SYSTEM” folder in the memory card or internal memory.
- The communication list cannot be transferred if no “SYSTEM” folder exists. The “SYSTEM” folder is created when the memory card is formatted using the camera.
- The communication list transferred to the internal memory or memory card is not deleted even when the internal memory or memory card is formatted. Use File Explorer to delete the list.

**Memo**
- The communication list transferred to a memory card can be used by importing it with [Import Com. Setting] in the menu of the camera. Refer to the Operating Manual of the camera for details.
Transferring Employee Information Files
(G900SE Only)

Database information, such as photographer information registered in the camera memo and employee ID used for managing the camera with passwords, can be transferred to the camera.

1. **Prepare the employee information data and save it in the CSV format.**

2. **Set [USB Connection] to [MTP] in the \( \mathbb{E} \) menu of the camera.**
   Refer to the Operating Manual of the camera for details.

3. **While ST-20 is running, connect the camera to the computer, and turn it on.**
   Refer to “Using DL-20” (p.5) for details.

4. **Select [Transfer Employee Information (MTP Transfer)] in the [Tools] menu of ST-20.**
   The [Transfer Employee Information] screen appears.

5. **Specify the file location.**

![Transfer Employee Information](image)

6. **Click [Transfer].**
   A confirmation screen appears.

7. **Click [OK].**
   The employee information is transferred to the camera.

8. **Click [OK].**

**Caution**
- Only one employee information file can be sent to the camera. Any employee information file previously transferred to the camera is overwritten.

**Memo**
- To use an employee information file in the camera, set [DB Co-op] to [On] in [NFC Setting] in the \( \mathbb{G} \) menu of the camera. Refer to the Operating Manual of the camera for details.
Setting Up the Camera Dedicated Server
(G900SE Only)

You can set up a computer as the dedicated server (SR-20 server) for the camera. The set computer functions as an FTP server to transfer camera images and a server to automatically transfer the camera update file.

1 Double-click the SR-20 icon in the system tray at the right end of the computer taskbar.
The SR-20 screen appears.

2 Make the settings on the [Main] tab.

   1 [Server]: Receives files in the folder specified with [Folder name].
   [Server+Camera]: Receives files in both the folder for [Server] and the folder for [Camera].
   [Camera]: Receive files in the folder set on the [FTP/FTPS Server Options] tab of ST-20. (p.16)

   2 Specify the path and file name of the log file for the connections status, the maximum file size, and number of files in the history.

   3 Set the [Min.] (minimum value) and [Max.] (maximum value) of the port number when a check mark is placed in [PASV] on the [FTP/FTPS Server Options] tab of ST-20. (p.16)

3 Make the settings on the [FTPS] tab (optional).

   1 Specify the secret key used when creating the certificate.

   2 Specify the server certificate file used when creating the certificate.

   3 Enter “990” to use an implicit port.

   4 Check the server certificate.

4 Set the port number for receiving files.
[Transfer Images]: 1 to 65535
[Clock Synchronization/Firmware Update/Settings Update]: 60111 to 65000
4 **Make the settings on the [Register File] tab.**

Click [Save] to register the files to be transferred to the camera.

| 1 | Register the camera firmware. |
| 2 | Register the camera memo list. Multiple lists can be registered and turned on or off in [Enabled]. |
| 3 | Register the communication list (SYSTEM.PRM) created using ST-20. (p.15) |
| 4 | Register the file (CAMERA.PRM) saved using [Camera Settings File] in the ⬇️ menu of the camera. |

5 **Click [Apply].**

**Memo**

- Once the SR-20 server has been set up, set the operation when the server is connected using [Server Sync.] in the ⬆️ menu of the camera. Refer to the Operating Manual of the camera for details.
- Right-click the SR-20 icon and place a check mark to [Enable auto launch] to launch SR-20 automatically when the computer starts.
- Launch SR-20 before synchronizing the date and time settings of the camera with the server clock using [Synchronize Clock] of the camera.